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BLUEcloud Analytics (BCA) for Analyst Users 
Revision Date: 4 October 2016 

 
 
BCA link:  https://na1-microstrategy.bc.sirsidynix.net/bcanalytics/asp/Main.aspx 
BCA page on RSA Support Site:  http://bit.ly/RSA-BCA 

 
User Names: Are individual to the user.  User logins are PERSONAL and access will 
be terminated for any user who shares their user name and password.  RSA does not 
host and can’t block access to the server which means we must tightly control access 
via individual user logins and strong passwords.  Note: Unlike other RSA reporting 
products, you can use this product from any internet connection on any computer. 
 
Passwords:  Each password is long and complex.  DO NOT CHANGE YOUR 

PASSWORD without RSA approval.  Long, complex passwords protect library and user 
data. 
 
Product info:  BLUEcloud Analytics is built using the MicroStrategy version 9.xx 

software.  You can Google many interesting things about this Fortune 500 reporting 
product.  If you get stuck trying to do something, you can probably find the answer 
somewhere online if you dig.  Or you can ask RSA staff.  Note: Web Reporter runs in 
MicroStrategy version 7.xx. 
 
Privileges Analyst Users Have:  View, run, and save personal copies of Shared 

Reports.  Create new reports from ‘super templates’.  View, run, create, and save Visual 
Dashboards.  Print, export to Excel, PDF and other formats, and scheduled reports via 
email.  Analyst Users are issued to RSA Full Online Library members. 
 
Reports vs Visual Dashboards:  These are different ways to view your data.  Reports 
are the Web Reporter equivalent in BCA while Visual Dashboards are the Director’s 
Station equivalent.  Think of reports as “Excel spreadsheets on steroids” and Visual 
Dashboards as reports with mixed media, columnar data, graphs, pie-charts, and more 
all on one page. Visual Dashboards require Flash in your browser and are designed to 
be viewed online.  Reports are generally designed to be exported as Excel or PDFs.  
Visual Dashboards will be covered in future training. 
 
Note: you can only subscribe via email to Reports.  You have to be logged into BCA to 
access Visual Dashboards.  However, you can export Visual Dashboard views as 
interactive PDF’s. 
 
Data freshness:  Data is refreshed each night around 1am.  In the future there may be 
hourly or a couple times a day refreshes.  For now, you are looking at yesterday’s data. 

https://na1-microstrategy.bc.sirsidynix.net/bcanalytics/asp/Main.aspx
http://bit.ly/RSA-BCA
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Browser Requirements:  Most modern browsers are supported, you should use either 

Chrome or Firefox.  Note: Microsoft Internet Explorer is not considered a modern 
browser anymore and should not be used with BCA.  Dashboards require Flash at this 
time.  In the future the plan is to move away from Flash to HTML 5 which is built into 
modern browsers. 
 
BCA Terminology:  BCA is designed to work with both Symphony and Horizon library 

automation systems.  Some terms will be familiar Symphony terms, others might be 
Horizon terms or new BCA terms descripting things in both systems.  SirsiDynix has 
created a Data Reference Guide that explains all BCA terms and shows what data they 
point to in our Symphony database. 
 
There is a copy of the BCA Data Reference Guide linked on the RSA support site in the 
RSA Reporting Products, BLUEcloud Analytics page. 
 
There is also guide to common WorkFlows displays with associated BCA terms linked 
on the same RSA support website page.  Look for the “BCA – WorkFlows Terminology 
Cheat Sheet.” 
 
Some common BCA Terms and who they appear in Symphony are as follows: 
 

Item Attributes (BCA name  Symphony/WorkFlows name): 
Item Barcode  Item ID 
Item Call Class  Class Scheme 
Item Collection  Home Location 
Item Notes  Public Notes 
Item Shelving ID  Call Number  
Item Status  Current Location 
Item Stat Period Checkouts  Checkouts This Calendar Year 
 
Catalog Attributes: 
Catalog Flex ID  Title Control Number 
 
Trans (Stat) Attributes: 
Trans Stat Icat 2  Item Cat 2 (Reading Level) 
Trans Stat Icat 3  Item Cat 3 (General Format) 
Trans Stat Station Library  Checkout Library 

 
Special Note on the “Beginning of Time”.  Any date in BCA that shows as 1/1/1900 
means NEVER.  I.E. in the Last Activity Date column, 1/1/1900 means the item has 
never been scanned in Workflows.  In dates like user expiration 1/1/1900 means the 
user never expires.  1/1/1900 is the beginning of time for BCA as well as the default 
display for no time data available. 
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Can I Mess Things Up?  BCA works from a snapshot of our Symphony database and 
does not change Symphony data.  You can play to your hearts content and the worst 
thing that will happen is that you mess up the look up your report and have to start 
again or reload the saved report to refresh back to a previous or the delivered look.  You 
shouldn’t (knock on wood) have the ability to overwrite any delivered report, only your 
own reports.  In other words, you shouldn’t have the ability to mess up anybody else. 
 
 

The Login Process:   
 
Go to the BCA link shown on the RSA support site main page, right side Quick Links 
section.  You’ll see a screen like the one below.  You can bookmark the page before 
you sign in if you wish. 
 

 
 
Enter your User name and Password.  You should see a project selector page OR be 
dropped right into BCA if you were already using BCA in your browser and got timed 
out. 
 
Select the BCA RSA project from the list of projects show.  There may be more than 

one project shown if RSA is working on a special project of some type.  There will be a 
project for the Quincy migration showing from Sept 2016 – March 2017. 
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BCA Home Page Elements: 
 

 
 
1.  Menu bar and site navigation hint:  The Star opens a dropdown with direct links to 

items 3 – 9 and the Logout link.  You can use this from any place in the system to 
jump somewhere else.  The house icon brings you back to this screen.  The arrows 
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move you back and forward in your current session history.  The folder with the up 
arrow takes you up one folder in the structure from your current point.  The BCA 
RSA part after the red arrow shows your current location in the system.  If you are in 
a report you can click the name to see the entire path and jump to another folder in 
the path. 

2.  Search Bar:  If you can’t remember where a report is stored, you can type a part of 

the report title and click the red magnifying glass to see a list of reports and folders 
that match your search terms. 

3.  Preferences:  Your preferences should have been pre-set during the initial setup of 
your user account.  You should only change settings here after notification from RSA 
staff.  Note, changing preferences can break your user account.  Do not adjust 
without consulting RSA staff. 

4.  Shared Reports:  This is where all the premade report templates developed by RSA 
staff show up.  There are various sub-folders of reports.  This is also where you go 
to access Visual Dashboard templates. 

5.  My Reports:  If you save a copy of a report template with your filter choices, this is 

where you’ll save to.  You can make sub-folders to better organize your saved 
reports.  If you choose to create a new report from one of the super templates, or 
make a new Visual Dashboard, you will save those reports here as well.  If you 
make a report and wish to share it with other libraries/staff members, RSA staff can 
copy a report in your My Reports folder into another user’s My Reports folder. 

6.  History List:  It is possible to subscribe to a report without sending it via email.  If 

you do so, that report will run at the scheduled time and then place a link to the 
report on this page.  There are better ways to setup reports you want to run in the 
future with saved prompts.  Reports send to the history list are stored temporarily 
here and may disappear in the future. 

7.  My Subscriptions:  This is where you save pre-prompted reports you know you’ll be 
running again in the future.  In a report, it you click the Home menu, then Create 
Personal View, you’ll save a copy of the report with your filter choices to the My 
Subscriptions folder.  In the future you can run the report with the same settings 
again by navigating here and clicking on the report.  This is also the folder where all 
reports you have scheduled to email live.  You can rerun those reports, change the 
subscription schedule, remove subscriptions, and more from this folder.  
Subscriptions are separated by type in this folder for easier navigation in the future. 

8.  New Dashboard:  Opens a blank Visual Dashboard report page.  You’ll be asked to 
select a ‘Cube’ of data to preload for the report.  Cubes of data are huge chunks of 
data that have been pre-processed specially to cut down on reporting time.  Cubes 
are separated into logical chunks (users, bills, items, etc.). 

9.  New Report:  Opens a selector with several ‘super templates’ of information with 
many, many filtering options.  You’ll be asked to select Objects (data elements or 
metrics) and filters.  You can select specific data elements to display (i.e. maybe all 
you want is a report with the User ID, User Profile and User Email address to use for 
a mailing list or something) and then the filter criteria to limit the displayed data 
(something like the user expiration date). By using just the filters you want and 
ignoring the rest you can create additional views of your data not available in the 
shared reports folders. 
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Running Reports: 
 
Click the Shared Reports Folder on the home screen to open all the reports developed 
by RSA staff.  As of 20 July 2016, the following folders of reports are available.  Note: 
some folders may be placeholders until the data has been added to BCA to allow us to 
make those reports. 
 

 
 
As you can see, we generally break reports into count reports and list reports.  In 
addition, there are folders for RSA-wide end of month and end of quarter/year reports. 
 
To run a report, select the folder best describing what you generally want, then look 
through the reports in the folder to find the one that best represents the data you need. 
 
Once you see the report you want, click the title of the report to run it.  For example, 
here is the ‘*Item Counts’ folder and some of the reports it contains. 
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Depending on the report you ran, it will either begin to run immediately or show a screen 
with one or more filters/prompts.  For example, clicking the “Count Items by Item Type – 
with Item Type filter” report shows the following filters/prompts. 
 
Note: filters and prompts are interchangeable terms and mean the same thing.  
Sometimes you might see them called filters while other times you might see prompts. 
 
This report has two filter prompts built into it.  The first is for Item Type, the second, 
which is a required filter, is for Item Library Code.  You must answer required prompts, if 
you leave a non-required prompt empty, the system will assume you didn’t want to filter 
by that particular thing. 
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1.  This is the list of available things to filter on in this prompt.  In this case, it’s an Item 

Type filter.   
2.  You can make selections one by one by double clicking values to move them to the 

Selected box on the right or you can highlight the values you want and click the 
single (top) right arrow to move them over.  The double right arrow moves ALL the 
values on the Available list (left) to the right.  The single and double left arrows move 
selected or all selections out of the Selected box. 

3.  This is the second of two filter selection areas.  Other filter types you will see are 
date values (with pop-up calendars to help you fill them in), checkboxes, or blank 
boxes where you could enter a specific value (like an item ID) to filter on.  The RED 
(Required) text next to the prompt name indicates you must make a selection in this 
prompt. 
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4.  After answering the prompts, scroll to the bottom of the page and click the Run 
Report button.  This is frequently missed by users or hidden if a report has several 
filter prompts and you’ll need to ensure you scroll all the way down to see it. 

 
I choose all the BLU-RAY and DVD item types and GU_GBURGPL as my item library 
and ran the report.  Here is the output. 
 

 
 
This is you main work area in BCA.  Across the top you have the familiar Star, Home, 
Go back/forward arrows, the Up One Folder icon and the name of the report in the 
navigation hint.  The blue line below sets off the report area. 
 
Just below the blue line are the report menus, then the menu icon bars (which change 
depending on which menu item you last clicked), then the report field with the report 
objects in the left pane and the actual report, filter data, and page-by field on the right. 
 
Notice that the Report Details contains the filter criteria you provided and could also 
show additional filtering criteria pre-programmed into the report.  Reports with user 
counts or lists frequently have hidden filters to remove system users.  These filters will 
show up in this section so that you know exactly what’s been filtered out. 
 
At the bottom is the full navigation bar showing you the path to the report you are in.  
Each level of this navigation bar is clickable. 
 
Each menu has different functions in it and an associated icon toolbar with icons for the 
most important or frequently used functions in that menu.  If you mouse over the menu 
icons they tell you what they are.   
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Home Menu: 
 

 
 
Please note the icon 2nd from right with the green question mark.  This is the re-prompt 
report icon.  This takes you back to the filter prompts and allows you to modify your filter 
settings. 
 

 
 
Save:  Saves the report AS PROMPTED to your My Reports folder.  This saves a copy 
of the report with your prompt answers as the defaults. 
 
Save As…:  Allows you to save the report WITHOUT your prompt answers as the 

defaults.  To do this, ensure #2 below (next page) is setup like the default shown in the 
picture (Filter and template will be prompted).  If you were to click the radio button for 
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#1, Save report as static, the report will make your current prompt answers the only 
thing the report will show.  It will never ask for prompts again, just rerun exactly what 
you saved.  This is generally not what you want to do. 
 

 
 
Undo and Redo:  Undo or redo your last actions in the report.  If you click something 

and change the look or data of the report you can click undo to remove your change. 
 
Grid, Graph, Grid and Graph:  Grid is the default output, as show in the finished 
report.  It looks like an Excel report.  Graph turns the data into one of several graphs 
which may or may not be helpful.  Grid and Graph shows you data as both a grid and a 
graph. 
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Add to History List:  This adds a temporary, prompted copy of the report to your 
history folder where you could run it again.   Reports sent to history stay for an unknown 
amount of time then go away.  Do not use this feature. 
 
Create Personal View:  This is what you use to save a pre-prompted report to have it 
run again in the future the way it’s setup now.  You’ll be asked to name the report or just 
accept the default.  To run the report in the future, go to the My Subscriptions folder and 
click the report.  The report will run again WITHOUT asking you to answer the prompts 
again.  If you have reports you run frequently without changing the prompt answers, this 
is your best option! 
 
Share…: Sets the security settings for the report you are looking at.  You can’t change 

these so just ignore this setting. 
 
Send Now…: Sends the current report via email to one or more email addresses.  You 
can send the report as data in the email body (HTML), or as an attached Excel file 
(formatted), a PDF, plan text file, or a CSV file.  You can also put a short (150 
characters or so) message with the data. 
 
Subscribe to:  Offers subscriptions to run the report on a set time period and send it to 

either: History list, E-mail, File or Printer.  The ONLY option you should use here is E-
mail.  File and Printer do not work and the History List is not reliable. 
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You’ll need to initially click the To: button to add one or more emails to your account.  
The schedule dropdown contains lots of options for times and days to run the report and 
email to it you.  The Delivery Format has the same options as the Send Now option 
above.  Again you can add a short message to the email.  There is also a checkbox to 
send the person subscribed to the report a preview of this scheduled report right away. 
 
Note: there is a separate guide for setting up a scheduled report available on the RSA 
Support Site. 
 
Export:  This allows you to export the data as one of the following file types: PDF, Excel 
with plain text (choose this is you want to sort the data in Excel), CVS file format, Excel 
with formatting (which looks like the report on screen but makes sorting impossible in 
some reports), HTML or Plain text. 
 
Print…:  Allows you to send the report to your printer.  The report is turned into a PDF 

then printed out. 
 
Full Screen: Gives you a bit more space by removing the top and report menu bars and 
the Report Objects panel on the left of the screen. 
 
 

Tools Menu: 
 

 
 
The tools menu allows you to show or hide many report modification or informational 
elements. 
 
New…:  Allows to you create a new report.  You’ll probably not use this. 

 
Create Dashboard:  This allows you to use the data element in the report as the 

beginning elements of a new Visual Dashboard.  Useful for creating more advanced 
graphs or nice looking Board Reports.  Beyond the scope of this training document. 
 
Show/Hide page element checks:  The next 3 sections of menu options allow you to 

show (checked) or hide (not checked) various information about the report you have 
run.  These options are mirrored as depressed (on) or normal (off/not showing) icons on 
the toolbar.  If you lose your filter answers (the Report Details menu option) view or 
want to turn something off to make more space,  Also you can turn on the View Filter 
here to filter the current report to show only certain parts of the data. 
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Report Options:  Allows you to change the look of the on screen or exported report 

data. 
 
Report Details Page:  Gives several bits of data about your report including the SQL 
statement used to run to report. 
 
 

Data Menu: 
 

 
 
This menu contains various options to directly affect the output of the report, add totals 
and subtotals, Refresh/Re-Prompt the data, etc. 
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Add View Filter Condition:  This allows you to search within an already run report to 

focus in on specific data.  This is a very powerful function to further refine your data set. 
 
Once you select this, it turns on the View Filter bar below the Report Details section, 
and allows you to select any data element in the report to further filter on.  For example, 
in the screenshot below, I choose the filter to show only Item Type DVD.   
 
If you have a large shelf list and only want to see items by a particular author or in a 
specific location, this is a good way to quickly limit down to that information. 
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Choose what data element to sub-filter on: 

 
 
Choose the specific data to look at: 

 
 
Output of view filter with all other data removed. 
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Sort…:  Shows an advanced sorting window allowing you to select a multi-level sort of 

the columns.  The grey up/down arrows in the report body header do the same thing for 
a single column. 
 
Drill…:  Would allow you to examine the data in that cell more closely.  In practice it 

doesn’t work as expected at this time because RSA can’t associate specific reports as 
drills.  If you try to use this it will frustrate you. 
 
Hide Nulls/Zeros:  Not currently applicable since nulls are hidden already.  Might 

become useful in the future. 
 
Reset Data:  Returns the data to the starting point if you have modified it since running 
the report. 
 
Refresh:  Refreshes the data against the database.  Currently has no effect since we 

only update the database once each morning at 1:30am. 
 
Re-prompt:  Returns you to the report setup/prompt screen and allows you to refine 
your reporting choices.  If you forgot a user profile or item type selection, this is the 
fastest way to add/remove them. 
 
Swap Rows and Columns:  Does exactly that, usually in unexpected ways.  It’s better 
to move individual rows/columns in the body of the report using the curved or Up arrow 
icons next the data element titles. 
 
Insert New Metric:  Allows you to create metrics of data on the fly.  Beyond the scope 
of training.  If you need a new metric, let RSA staff know so we can make it for 
everybody. 
 
Rename/Edit Objects:  Don’t like the column or row header text, this is where you 
change it. 
 
Edit Attribute Forms…:  You will never use this option.  Move along. 

 
Show Totals:  In the example shown, the report totals are the yellow lines.  The look 

and coloring vary depending on the grid theme.  You can show or hide total and sub-
total counts in this item.  
 
Edit Totals:  Allows you to change the total type (count, average, median, etc) and 

change the levels that show sub-totals.   
 
Toggle Thresholds and Visual Threshold Editor:  Allow you to make the report 
formatting change based on the data of the cells.  You could force larger amounts to 
show as red text or assign colors to a range of values.  Beyond the scope of this 
training. 
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Grid Menu: 
 

 
 
The grid menu doesn’t have a drop-down list of options for some reason, only icons. 
 
The icons you’ve already seen are (left to right): 
Save 
Undo 
Redo 
Grid view 
Graph view 
Grid and Graph view 
 
Grid Theme:  This contains a list of various color schemes for the report.  Some are 

better than others.  Some don’t group rows or columns by default which is helpful for 
exporting via email to Excel.  Clicking the dropdown gives a display of your choices.  If 
you want to export to Excel, the last theme in the list, Table, might be your best option 
with Monochrome coming in a close second. 
 
Banding:  Clicking this icon ‘depresses’ it visually and turns on an every other row 

highlighting feature. 
 
Outline:  Makes your data look bad, most of the time anyway.  Once in a great while it 
is visually appealing. 
 
Merge Column Headers / Merge Row Headers:  This is what turns on or off the 

‘whitespace’ in a report.  While merging headers makes the report easier to understand 
and better shows relationships, it totally breaks Excel’s ability to do sorting if a report is 
sent via email or exported as formatted text.  If you want to export a report to Excel to 
manipulate the data, make sure you unclick both column and row header merging. 
 
Lock Column Headers / Lock Row Headers:  If the Lock Row Headers is depressed 

(on), then the headers will not move, the scroll bar goes away, and you must use the 
mouse wheel to scroll through the report data.  This is essentially like using the Freeze 
Pane options in Excel. 
 
Auto-fit to Contents / Auto Fit to Window:  Select one or the other.  Autofit to window 
expands the columns to fit the width of the window.  Auto fit to contents makes the 
columns just wide enough for the data in them. 
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Format menu: 
 

 
 
The Format Menu also has very few options. 
 

 
 
Advanced Formatting…:  This is much like the formatting options in Word or Excel.  
They apply to all the metrics, or individual metrics if you have more than one in a report.  
This allows you to change the type of metric to currency or other types, give it color or x 
number of decimal places. 
 
The icons in the Format menu icon bar are shortcuts to various advanced formatting 
functions. 


